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COURSE INFORMATION 
Course title: Marketing Research 
Course code: BAMA 508 Credits: 1.5 
Session, term, period: 2023W2 Class location: TBD 
Section(s): 821 Class times: Jan 5-7, 2024 
Course duration: Jan 5-7, 2024  Pre-requisites: n/a 
Division: Marketing and Behavioural Science Co-requisites n/a 
Program: IMBA   

INSTRUCTOR INFORMATION 
Instructor: Dr. Yanwen Wang 
Phone: (+1) 604-827-0078   
Email: yanwen.wang@sauder.ubc.ca    
 

COURSE DESCRIPTION 
The learning objectives are to equip students with (1) a familiarity with marketing research frameworks 
and terminology, (2) an understanding of both the value and limitations of the most widely-used market 
research techniques, (3) a set of research tools to address substantive marketing problems including 
data visualization, evaluating advertising and promotion campaigns, forecasting market demand, pricing 
of new products, and (4) sufficient hands-on experience with research techniques/tools so that 
managers’ marketing research questions can be answered.  

COURSE FORMAT 
Class time will be used for a combination of lectures, discussion, solving sample problems, and case 
discussions. Attendance is expected to accomplish the learning objectives below. Lectures and 
discussions will assume that students having pre-read the corresponding class materials as listed in the 
course schedule below. 
 
To achieve the course objectives, we use a combination of lectures, case discussion, lab session, and 
exercises. The course will be built upon your existing statistical and analytical skills. You are expected to 
use Tableau and interpret outputs from Excel Add-Ins of Analysis ToolPak. An important aspect of the 
course involves getting “hands-on” experience with Tableau and Excel analysis packages. Analysis of cases 
also form the basis for applying the concepts in real-world situations, and you are expected to come well 
prepared for these discussions.  

LEARNING OBJECTIVES 
By the end of this course, students will be able to: 
1. Select and apply appropriate marketing research methods to real-world business questions 
2. Apply Tableau and Excel to conduct data analyses and interpret the outputs to answer marketing 

research questions  
3. Evaluate the value and limitations of the applied marketing research methods and recommend 

business strategies based on the data analyses results. 
 

mailto:yanwen.wang@sauder.ubc.ca
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ASSESSMENTS 

Summary 
Component Weight 
Individual Assignments (2*6%) 12% 
In-class Group Assignments (4*12%) 48% 
Final project 20% 
Class participation    20% 
Total 100% 
 

Details of Assessments 

Class participation 20% 
We will devote a significant portion of class time to solving practice problems and cases. In order to 
maximize the benefits to you, it is of utmost importance that you be prepared to discuss the materials 
during class. Effective class participation includes: 

- (1) complete all the class-activity surveys on time. All the class surveys are designed to help 
facilitate in-class discussions. 

- (2) install all the software prior to the in-class lab sessions,  
- (3) ask questions about concepts related to class or lecture contents,  
- (4) share your experience or point of view with the class,   
- (5) email me any marketing research examples from the media and/or your own industry 

experience, which you feel may enhance the class discussion.  
Note that attending class and not speaking has neither a positive nor a negative impact on your 
participation score.  
 

Individual Assignments 12% 
There will be two individual assignments that may occur in-class or after-class throughout the term. 
Each will be worth 6% of the course grade. 
 

In-class Group Assignments 48% 
You will form groups for the in-class group exercises. Given the registered class size, you will form teams 
with 3 members. You will stay in the same group for all the group assignments. Please sign up for your 
group on Canvas under the section of “People -> Marketing Research Groups” by Wed Dec 20 11:59pm 
(Beijing time). 
 
Group assignments help you learn market research skills through practice and from each other. All the 
group exercises must be prepared individually for each group. Sharing work across groups is strictly 
prohibited in line with the UBC Honor Code. Peer evaluations will be conducted at the end of class. 
 

Final project 20% 
There will be one final group project. You will form a group of size four. You are allowed to form a team 
different from your in-class group exercise teams. Working with and learning from different class mates 
are encouraged. 
 
Peer evaluations will be completed at the end of the term to provide feedbacks on how team members 
think each member (including their own) is contributing to the final group project. Individual grades on 
group assignment may be subject to adjustment following my review of peer evaluations. Reductions 
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can be significant, ranging from a decrease of 10% to a decrease of 100% if an individual has contributed 
little or nothing to the team’s work.  In most instances, where team members are reliable and 
contribute, no adjustments are made.  
 
Students are required to complete peer evaluations by the specified deadline (announced before the 
end of the class). Failure to complete the evaluation will result in a 10% reduction in the mark received 
for the group assignment portion of this course (for example if you got 40 out of 40 on the group 
assignment score and did not complete peer evaluations your total group score will be adjusted to 36). 
Please ensure that you complete the peer evaluations on time. 
 

LEARNING MATERIALS 
Course pack 
There is no required textbook for this course. Instead, we will use a combination of cases and articles 
for readings. All the class materials can be accessed from Canvas. 
 
You will also be required to use several market research tools including Tableau, and Excel Analysis 
ToolPak, in this course. Please follow the instructions below to install the software. 

 

Tableau 

1. Download the latest version of Tableau Desktop and Tableau Prep Builder here 
https://www.tableau.com/products/desktop  

2. Click on the link above, start a free trial, enter registration information, and download Tableau 
Desktop. 

3. You can start with a 14-day free trial or use the product key: TBD 

4. Already have a copy of Tableau Desktop installed? Update your license in the application: Help 
menu → Manage Product Keys 

5. If you are new to Tableau, please review Data Analytics for University Students guide to get 
started. 

6. Students can continue using Tableau after the class is over by individually requesting their 
own one-year license through the Tableau for Students program here. 

 
Excel Analysis Toolpak 
You must have Excel 2019/2016 for Mac or 2019/2016/2013 for Window. UBC provides access to 
download Microsoft 365 for free (Microsoft 365 includes Excel 2016). Here’s the link: 
https://it.ubc.ca/services/desktop-print-services/software-licensing/office-365-students 
 
Mac Users 

- Click the Tools menu, and then click Excel Add-Ins. 
- In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK. 
- If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. 
- If you get prompted that the Analysis ToolPak is not currently installed on your computer, click 

Yes to install it. 

https://www.tableau.com/products/desktop
https://www.tableau.com/university-students
http://tableau.com/students
https://it.ubc.ca/services/desktop-print-services/software-licensing/office-365-students
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- Quit and restart Excel. Now the Data Analysis command is available on the Data tab and the 
Tools menu. 

 
Windows Users 

- Click the File tab, and then click Options. 
- Click Add-Ins, and then in the Manage box, select Excel Add-ins. 
- Click Go. In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK. 
- If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. 
- If you get prompted that the Analysis ToolPak is not currently installed on your computer, click 

Yes to install it. After you load the Analysis ToolPak, the Data Analysis command is available in 
the Analysis group on the Data tab. 

 
Qualtrics 
You can access https://ubc.qualtrics.com for free using your CWL account.  
 
   

COURSE-SPECIFIC POLICIES AND RESOURCES 

Missed or late assignments, and regrading of assessments 
▪ Late submissions will not be accepted and will receive a grade of zero. 
▪ Requests for regrading of assignments or exams must be submitted via email within one week of the 

assessment being returned to the class. The request must identify the reason(s) why you believe 
your answer(s) and score(s) should be reviewed. Re-grading applies to the entire content of the 
submitted assignment. The outcome may be an increase, no change, or decrease in the assigned 
grade. The new grade is final. 

Academic Concessions 
If extenuating circumstances arise, please contact the RHL Graduate School program office as early as 
reasonably possible, and submit an Academic Concession Request & Declaration Form 
https://webforms.sauder.ubc.ca/academic-concession-rhlee. If an academic concession is granted 
during the course, the student will be provided options by RHL, or by the instructor in consultation with 
RHL, per UBC’s policy on Academic Concession. 

Other Course Policies and Resources 
Electronic devices should not be used except when directed by the instructor. This course will use 
Tableau and Excel data analysis tools. Please bring a laptop, or tablet to class for the in-class exercise or 
lab sessions. 

POLICIES APPLICABLE TO COURSES IN THE ROBERT H. LEE GRADUATE SCHOOL 

Attendance 
Excepting extenuating circumstances, students are expected to attend 100% of their scheduled class 
hours. Absent students limit their own academic potential, and that of their classmates, and cause 
unnecessary disruption to the learning environment. Students missing more than 20% of the total 
scheduled class hours for a course (including classes held during the add/drop period) without having 
received an academic concession will be withdrawn from that course. Withdrawals, depending on 
timing, could result in a “W” or an “F” standing on the transcript. 

https://ubc.qualtrics.com/
https://webforms.sauder.ubc.ca/academic-concession-rhlee
http://www.calendar.ubc.ca/vancouver/index.cfm?tree=3,329,0,0
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Punctuality 
Students are expected to arrive for classes and activities on time and fully prepared to engage. Late 
arrivals may be refused entry at the discretion of the instructor or activity lead. Students arriving later 
than halfway through a scheduled class will be treated as absent for that class. 

Electronic Devices 
Devices such as laptops, tablets, and cell phones are not permitted to be used in class unless directed by 
the instructor for in-class activities. Students who do not follow the School’s policy in this regard may be 
required to leave the room for the remainder of the class, so that they do not distract others. Research 
shows that students’ use of laptops in class has negative implications for the learning environment, 
including reducing their own grades and the grades of those sitting around them.  

Citation Style 
Please use the American Psychological Association (APA) reference style to cite your sources. 
 
Details of the above policies and other RHL Policies are available at: 
http://www.calendar.ubc.ca/vancouver/index.cfm?tree=12,199,506,1625  

UNIVERSITY POLICIES AND RESOURCES  
UBC provides resources to support student learning and to maintain healthy lifestyles but recognizes 
that sometimes crises arise and so there are additional resources to access including those for survivors 
of sexual violence. UBC values respect for the person and ideas of all members of the academic 
community. Harassment and discrimination are not tolerated nor is suppression of academic freedom. 
UBC provides appropriate accommodation for students with disabilities and for religious observances. 
UBC values academic honesty and students are expected to acknowledge the ideas generated by others 
and to uphold the highest academic standards in all of their actions. Details of the policies and how to 
access support are available on the UBC Senate website at https://senate.ubc.ca/policies-resources-
support-student-success. 
 

Respect for Equity, Diversity, and Inclusion 
The UBC Sauder School of Business strives to promote an intellectual community that is enhanced by 
diversity along various dimensions including status as a First Nation, Metis, Inuit, or Indigenous person, 
race, ethnicity, gender identity, sexual orientation, religion, political beliefs, social class, and/or 
disability. It is critical that students from diverse backgrounds and perspectives be valued in and well-
served by their courses. Furthermore, the diversity that students bring to the classroom should be 
viewed as a resource, benefit, and source of strength for your learning experience. It is expected that all 
students and members of our community conduct themselves with empathy and respect for others.  
 

Academic Integrity 
The academic enterprise is founded on honesty, civility, and integrity. As members of this enterprise, all 
students are expected to know, understand, and follow the codes of conduct regarding academic 
integrity. At the most basic level, this means submitting only original work done by you and 
acknowledging all sources of information or ideas and attributing them to others as required. This also 
means you should not cheat, copy, or mislead others about what is your work. Violations of academic 
integrity (i.e., misconduct) lead to the breakdown of the academic enterprise, and therefore serious 
consequences arise and harsh sanctions are imposed. For example, incidences of plagiarism or cheating 
may result in a mark of zero on the assignment or exam and more serious consequences may apply if 

http://www.calendar.ubc.ca/vancouver/index.cfm?tree=12,199,506,1625
https://senate.ubc.ca/policies-resources-support-student-success
https://senate.ubc.ca/policies-resources-support-student-success


  Syllabus 

 

  Jan 7, 2023 6 BAMA508 821 

Program: IMBA 

the matter is referred to the President’s Advisory Committee on Student Discipline. Careful records are 
kept in order to monitor and prevent recurrences.  
 

Academic Freedom and Students Studying from Outside Canada 
During this pandemic, the shift to online learning has greatly altered teaching and studying at UBC, 
including changes to health and safety considerations. Keep in mind that some UBC courses might cover 
topics that are censored or considered illegal by non-Canadian governments. This may include, but is not 
limited to, human rights, representative government, defamation, obscenity, gender or sexuality, and 
historical or current geopolitical controversies. If you are a student living abroad, you will be subject to 
the laws of your local jurisdiction, and your local authorities might limit your access to course material 
or take punitive action against you. UBC is strongly committed to academic freedom, but has no control 
over foreign authorities (please visit http://www.calendar.ubc.ca/vancouver/index.cfm?tree=3,33,86,0  
for an articulation of the values of the University conveyed in the Senate Statement on Academic 
Freedom). Thus, we recognize that students will have legitimate reason to exercise caution in studying 
certain subjects. If you have concerns regarding your personal situation, consider postponing taking a 
course with manifest risks, until you are back on campus or reach out to your academic advisor to find 
substitute courses. For further information and support, please visit: http://academic.ubc.ca/support-
resources/freedom-expression 

COPYRIGHT  
All materials of this course (course handouts, lecture slides, assessments, course readings, etc.) are the 
intellectual property of the instructor or licensed to be used in this course by the copyright owner. 
Redistribution of these materials by any means without permission of the copyright holder(s) 
constitutes a breach of copyright and may lead to academic discipline and could be subject to legal 
action. Any lecture recordings are for the sole use of the instructor and students enrolled in the class. In 
no case may the lecture recording or part of the recording be used by students for any other purpose, 
either personal or commercial. Further, audio or video recording of classes are not permitted without 
the prior consent of the instructor. Students may not share class Zoom links or invite others who are not 
registered to view sessions.  

ACKNOWLEDGEMENT 
UBC’s Point Grey Campus is located on the traditional, ancestral, and unceded territory of the 
xwməθkwəy̓əm (Musqueam) people, who for millennia have passed on their culture, history, and 
traditions from one generation to the next on this site. 

 

 
  

http://www.calendar.ubc.ca/vancouver/index.cfm?tree=3,33,86,0
http://academic.ubc.ca/support-resources/freedom-expression
http://academic.ubc.ca/support-resources/freedom-expression
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COURSE SCHEDULE  
 (Subject to change with class consultation) 

Date Class Topic Activities or Assessments due 

Jan 5  #1: Introduction  Complete all the surveys before class 
Due IA 1: Conquistador beer case study 

Jan 5  #2: Backward Market Research In-class GA1: Conquistador beer case study 

Jan 5  #3: Tableau Install Tableau before class 

   

Jan 6  #4: Tableau and JD.om In-class GA 2 – JD.com 

Jan 6 #5: Linear Regression and Demand 
Forecast 

Install Excel Add-in Toolpaks before class 
Due IA 2: Box Office Revenues 

Jan 6 #6: Demand Forecast and Promotion In-class GA 3 – Kraft exercise 

Jan 6 #7: Targeting & Recommender Systems  

   

Jan 7 #8: Field Experiment Design and Analysis Read “Star Digital Assessing the Effectiveness 
of Display Ads”  
In-class GA 4 – StarDigital Field Experiment 
Analysis 

Jan 7 #9 ChatGPT & New Trends Read “OpenAI and the Large Language Model 
Market” 

   

 Midnight Jan 28, 2024 midnight Beijing time 

 


